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Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other countries. Other product and company names mentioned herein are 
trademarks or registered trademarks of their respective companies.

"Microsoft® Windows®" is abbreviated to "Windows".

© 2010 Shimadzu Corporation. All rights reserved.

<< Notices >>
All rights are reserved, including those to reproduce this document or parts there of in any form without permission in writing 
from Shimadzu Corporation.
Information in this document is subject to change without notice and does not represent a commitment on the part of the 
vendor.
Any errors or omissions which may have occurred in this document despite the utmost care taken in its production will be 
corrected as soon as possible, but not necessarily immediately upon detection. We appreciate notification of any errors or 
omissions.
Shimadzu Corporation is not responsible for errors or injuries resulting from following the instructions in this document.
Shimadzu Corporation is not responsible for errors or injuries resulting from the use of equipment by the customer.
Replacement parts for this product will be available for a period of seven (7) years after discontinuation of the product. 
Thereafter, such parts may cease to be available. Note, however, that the availability of parts not manufactured by 
Shimadzu Corporation is determined by the manufacturer of those parts.
The contents of PC hard drives may be lost due to unforeseen circumstances. In order to protect important data, be sure to 
make backup copies on a regular basis.

In order to ensure the safe use of this product, observe the following points.

Follow the procedures described in the instruction manual.

Observe precautionary information.

Do not disassemble or modify this product without permission.

If repairs are required, contact your Shimadzu representative.
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Thank you for purchasing the GCMS-QP2010-series gas chromatograph mass spectrometer. This document is 
intended to explain basic operations to first-time users. Refer to the instruction manual or the appendix of this 
document for more details, including information related to maintenance and inspection.

This document assumes that the user has a working knowledge of Windows. There are references to functions and 
terminology specific to Windows; refer to a Windows user manual as necessary. Users who have never worked with 
Windows should read a Windows user manual before using this document.

Introduction
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Shimadzu Corporation provides the following warranty for this product.

Details

* If a warranty certificate or a similar form of document is provided with the product, or if a contract specifying warranty terms has been 
signed, then the regulations specified in such a document take precedence.
The warranty period for products with special specifications or for system products is specified separately.

Product Warranty

1. Period: Please contact your Shimadzu representative for information concerning the extent of 
your product's warranty.

2. Terms: If a fault attributable to Shimadzu Corporation occurs within the warranty period, we will 
perform the necessary repairs or part replacement free of charge. Note, however, that it 
may not be possible to replace products that have short life cycles, such as PCs and their 
peripheral devices and parts, with the same models.

3. Limitation of Liability 1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for special, 
indirect, consequential, incidental or punitive damages, however caused regardless of the 
theory of liability, arising out of or related to the use of or inability to use the product, even if 
Shimadzu has been advised of the possibility of such damage.

2) In no event will Shimadzu's liability to you, whether in contract, tort (including negligence), 
or otherwise, exceed the amount you paid for the product.

4. Items Not Covered: The following items are not covered by this warranty, even if they occur during the 
warranty period.
1) Faults resulting from incorrect use
2) Faults resulting from repairs or modifications implemented by parties other than Shimadzu 

Corporation or companies designated by Shimadzu Corporation
3) Faults occurring after use in combination with hardware or software other than that 

designated by Shimadzu Corporation
4) Faults in equipment and damage to data and software, including the OS, resulting from 

computer viruses
5) Faults in equipment and damage to data and software, including the OS, resulting from 

power failures, including power interruptions and momentary voltage drops
6) Faults in equipment and damage to data and software, including the OS, resulting from 

turning OFF the power switch on the equipment without following the proper shutdown 
procedures

7) Faults not originating in the equipment itself
8) Faults occurring after use in severe environmental conditions, such as those subject to high 

temperatures, high humidity levels, corrosive gases, or vibrations
9) Faults resulting from fires, earthquakes and other natural disasters, contamination by 

radioactive or toxic substances, wars, riots, criminal activities, and other types of force 
majeure

10)Faults occurring after the product is moved or transported following initial installation
11) Faults occurring in consumable parts or parts dependent on them

Note: Recording media, such as floppy disks and CD-ROMs, are also regarded as 
consumable parts.
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This operation guide uses the notation described below.

About This Operation Guide

Notation

Notation Meaning

! WARNING Indicates a potentially hazardous situation which, if not avoided, could result in serious injury or 
possibly death.

! CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor to moderate 
injury or equipment damage.

Indicates additional information that is provided to ensure the proper use of this product.

^ Reference Indicates the location of related information.
"Items indicated by this notation mean that this (new) feature/function is downward compatible with 
version 2.5. The new features are designed to make the software easier to use and/or increase 
productivity. However, the user still has the option to either use the same method used in version 2.5 
or use the new features by following the steps provided in this manual."

[  ] Indicates items displayed on the screen, such as buttons, menu selections, settings, windows, and 
icons. Example: Click [OK].
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These safety precautions contain important safety-related information. Be sure to read them before using the product 
and observe them during use.

Installation Site Precautions

Do not install the product in locations subject to large amounts of corrosive gas or dust. Otherwise, performance may 
be adversely affected and the product's service life may be shortened.

Safety Precautions

! WARNING

• Making internal repairs to the product is potentially dangerous. Such repairs must be performed by 
specially trained Shimadzu personnel.

• Do not disassemble or modify the product without authorization. 
Doing so may compromise safety.

• Read the instruction manual thoroughly before handling or operating the equipment, and be sure to 
following the procedures described.
Not handling the equipment as described is potentially dangerous.

! WARNING

• The solvents used with the gas chromatograph mass spectrometer may be flammable or toxic. Install 
the product in a well-ventilated room.
Otherwise, solvent vapors may cause poisoning, or ignite and cause a fire.

• Do not use this product in an environment containing combustible gases.
Doing so may cause a fire.

• Do not place flammable materials near the column oven exhaust at the back of the gas 
chromatograph.
Doing so may cause a fire.

• Install the product on a surface that is level, stable, and strong enough to support the product's 
weight.
Otherwise, the product may tip over or fall off the surface.
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High-Pressure Gas Precautions

Operation Precautions

! WARNING

• High-pressure gas cylinders are used to supply the carrier gas. Follow the instructions received from 
the cylinder suppliers and handle the cylinders carefully. 
Not doing so may cause poisoning or a fire.

• Keep the cylinders in a well-ventilated outdoor location that is not directly exposed to sunlight, and use pipes 
to convey the gas indoors. For liquefied gases, this is required by law.

• Ensure that the temperature of gas cylinders never exceeds 40 ºC and that there are no naked flames within 
2 m of the cylinders.

• Ensure that the installation site is well ventilated and, as part of the daily inspection procedure, check for gas 
leaks using soapy water. Do not smoke or use open flames within 5 m of equipment using highly combustible 
gases, such as acetylene, hydrogen, and propane, or potentially combustible gases, such as oxygen and 
nitrous oxide. Keep a suitable fire extinguisher nearby at all times.

• Secure the cylinders with ropes or by some other method to prevent them from falling over.
• Be sure to use oil-free pressure reducing valves. Also, do not use pipes in which oil is present on the inner 

surfaces that make contact with the gas.
• After using the gas, close the main valve immediately.
• Check that the pressure gauges are functional at least once every three months.
• Warning signs (adhesive aluminum plates) that indicate hydrogen gas use are provided free of charge. 

Contact your Shimadzu representative in cases of particular necessity.

Legal authorization is required to use cylinders with a capacity of 300 m3 or greater.
Refer to high-pressure gas control laws, liquid petroleum gas safety regulations, general high-pressure gas 
safety regulations, and fire safety laws for more information.

! WARNING

• Wear safety glasses when handling solvents or when injecting samples into the gas chromatograph.
If solvent gets into the eyes, it may cause blindness. If solvent does get into the eyes, immediately flush with 
large amounts of water and seek medical attention.

• Do not place solvents near PCs, printers, or other types of office equipment.
Doing so may cause a fire or equipment failure.

• Do not use flammable sprays (e.g., hair sprays and insecticide sprays) near the product.
They may ignite and cause a fire.
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Take the measures described below in the event of an emergency, such as a malfunction of the gas chromatograph 
mass spectrometer.
Before resuming operation, take appropriate precautions and, if necessary, contact your Shimadzu representative.

Handling Emergencies

Emergency Shutdown Procedure
1 Turn OFF the gas chromatograph mass spectrometer.

2 Turn OFF all accessories.

3 Close the main valves for the pipes supplying carrier gas, hydrogen, and air.

4 Disconnect the power supply.

If the power cable is attached to a switchboard, turn OFF the switchboard.

If the power cable is plugged into an outlet, unplug the cable.
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1Overall Configuration of 
GCMSsolution

1.1 Programs
GCMSsolution is made up of the programs described below.
Select the program that is appropriate for the purpose (e.g., analysis or data processing).

^  Ver. 2.5

This manual describes operating instructions primarily for new features added in GCMSsolution Version 2.6. 

However, items indicated with "^  Ver. 2.5" can also be performed using previous methods. Use 
whichever procedure is easier. 

Icons and windows for functions that can only be used on QP2010 Ultra or QP2010 SE model will not be 
displayed on the software if the GCMS model used is QP2010, QP2010 Plus or QP2010S.

Icon Name Description

GCMS Real 
Time Analysis

Used to start up and shut down the instrument, make configuration 
settings, and perform analysis.

GCMS Analysis 
Editor

Used to create and edit method files and batch files during analysis. 

GCMS Postrun 
Analysis

Used to perform qualitative and quantitative processing, print reports, and 
perform other tasks involving data processing.

GCMS Browser Used to perform qualitative and quantitative processing, print reports, and 
perform other data processing tasks for multiple data files. 
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1.2 Flowchart of Operating Procedure
Start up GC/MS system 

• Switch the power ON
• Specify maintenance and configuration settings, etc.
• Start up vacuum system 
• Check for vacuum leaks 

^  P.13Execute autotuning 

Qualitative Analysis Quantitative Analysis

1 Create method file 

• Specify instrument parameters 
Specify Scan mode

• Specify similarity search 
parameters 

2 Acquire data     

3 Analyze data  

• Display mass spectrum 
• Perform similarity search 
• Register displayed spectrum 

4 Print report

• Edit report 
• Output report 

1 Perform qualitative analysis
     (standard sample)  
  Use standard samples to confirm retention 
   times for target compounds 

2 Create method file  

  <Quantitative analysis using Scan mode> 
• Create compound table 

  <Quantitative analysis using SIM mode> 
• Create compound table 
• Create SIM table 

3 Acquire data 

5 Print report

• Edit report 
• Output report 

4 Analyze data

• Check and correct 
calibration curve

• Calculate quantitative 
values for samples with 
unknown concentrations 

Shut down the instrument
• Shut down the vacuum system 
• Switch the power OFF 

^  P.3

^  P.20

^  P.26

^  P.34

^  P.43

^  P.20

^  P.48

^  P.55

^  P.73

^  P.60

^  P.76
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2Starting GC/MS

2.1 Turning ON the Power
Switch ON any peripheral or accessory equipment connected to the system, before switching ON the 
main GC/MS system. 

1 Turn ON the power to the GC.

2 Turn ON the power to the MS.

3 Turn ON the power to the PC, printer, and display.

GCMS

GC power switch

Front Side

MS power switch

Back Side 
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4 Double-click the (GCMS Real Time Analysis) icon.
The [GCMS Real Time Analysis] program starts.

5 Click [OK].

2.2 Layout of Operating Areas 

No. Name GCMS Program Explanation
1 Title Bar Real Time Analysis, 

Analysis Editor, Postrun 
Analysis, and Browser

Displays the name of the program, process, and file 
currently running or being processed.

2 Menu Bar Real Time Analysis, 
Analysis Editor, Postrun 
Analysis, and Browser

Displays command menus corresponding to the window 
currently open. 

3 Toolbar Real Time Analysis, 
Analysis Editor, Postrun 
Analysis, and Browser

Displays command tool buttons corresponding to the 
window currently open. 

1

4

2 3

6 5

1

2 3

Title Bar 
Menu Bar Toolbar

Assistant Bar

Data Explorer Instrument 
Monitor 

4

6

Assistant Bar

Data Explorer 

Title Bar 
Menu Bar Toolbar

GCMS Real Time Analysis GCMS Postrun Analysis 
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2.3  Inspecting Consumable Items and Maintenance Parts

2
The assistant bar, instrument monitor, and Data Explorer can be shown or hidden by selecting [Show/Hide] 
on the [View] menu. 

2.3 Inspecting Consumable Items and Maintenance 
Parts
Check the state of the GC/MS consumable items using the procedure described below.

1 Move the mouse pointer over the icon for a consumable item in the instrument monitor 
to display the current state and the recommended replacement point for the 
corresponding item.
When a consumable item approaches its recommended maximum usage frequency, the background of 
the corresponding icon turns black to alert the user.

 
This note is shown when mouse pointer is moved over the septum icon.  This means that the septum has 
been used 13 times out of a maximum 100 times.

When replacing the analysis column, or when a consumable item has passed its recommended 
replacement point, perform maintenance with reference to "Appendix D Maintenance" P.83.

Depending on the analysis content, the appropriate replacement frequency may be greater than the 
recommended frequency. 

4 Assistant Bar Real Time Analysis, 
Analysis Editor, Postrun 
Analysis, and Browser

Command icons are arranged in order of typical operation 
sequence. The assistant bar is named according to the 
window that is currently open. For example, when the 
[Batch] window is open, the assistant bar is named the 
[Batch] assistant bar. 

5 Instrument Monitor Real Time Analysis Displays analytical instrument parameter values in real 
time. 

6 Data Explorer Real Time Analysis, 
Analysis Editor, Postrun 
Analysis, and Browser

Used to easily load analytical data or method files. It lists 
files in the selected folder, according to file type. 

No. Name GCMS Program Explanation
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2.4 System Configuration
Check and set the modules used for analysis using the procedures described below.

2.4.1 Setting the Modules Used for Analysis

1 Click the [System Configuration] icon on the [Real Time] assistant bar. 
The [System Configuration] window opens.

2 Check that the components shown in the [Modules Used for Analysis] area correspond 
to the actual modules in the GC/MS system that are to be used for the analysis.

If the modules to be used for current analysis do not correspond to the modules shown in 
this window, set as shown in the following example:

1 Select [AOC-20i+s] in the [Available Modules] area if for example, AOC-20i with AOC-20s are to be 
used for analysis.

2 Click to register the module in [Modules Used for Analysis].

1 2
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2.4  System Configuration

2

2.4.2 Checking Column Information
Information for the column attached to the instrument must be specified correctly. 
Check or change the column information settings after installing a column.

1 Double-click the (Column) icon in [Modules Used for Analysis].
The [Modules of Analytical Line#] window opens.

If the column to be used is not displayed under [Selected Column] area:

1 Click the name of the column to be used in the [Registered Columns] table.

2 Click [Select].
The column information is displayed under [Selected Column].
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If the column to be used is not registered:

1 Click [Add].
A row is added.

2 Enter the column information.
Column information is usually indicated on the packaging box of the column, on the column tag, or in 
the column specification sheet that is usually included inside the column box.

The maximum temperature that can be specified for the column oven, interface, and sample 
injection unit is normally the [Max. Usable Temp] setting entered here. For the protection of columns, 
always enter a [Max. Usable Temp] setting. 
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2.4  System Configuration

2

2 Click [OK].
The [System Configuration] window returns.

2.4.3 Enabling the Modules Used for Analysis

1 Click [Set].
The system configuration information is transferred to the instrument.
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2.5 Vacuum System Startup
Open the carrier gas cylinder valve to supply carrier gas. 

If carrier gas is being controlled by accessory/peripheral equipment, use that equipment to supply carrier 
gas before starting the vacuum system. 

1 Click the [Vacuum Control] icon on the [Real Time] assistant bar.
The [Vacuum Control] window opens.

2 Click [Auto Startup].
The vacuum system starts.

3 When [Completed] is displayed, click [Close].
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2.6  Checking for Vacuum Leakage

2

2.6 Checking for Vacuum Leakage

1 Wait for 10 minutes after starting up the vacuum system.

2 Click the [Tuning] icon on the [Real Time] assistant bar.
The [Tuning] window opens.

3 Click the [Peak Monitor View] icon on the [Tuning] assistant bar.
The [Peak Monitor] window opens.
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4 Check for vacuum leaks. 

1 Click the arrow button in [Monitor Group] setting, and select [Water, Air] from the list.

2 Click (Filament ON/OFF) to turn ON the filament. Peaks will be displayed in the three 
windows.

3 Change the detector voltage gradually by clicking the up or down arrow buttons so that the peak 
height for m/z 18 (water) corresponds to half the height of the display window.

4 Compare the peak heights for m/z 18 (water) and m/z 28 (nitrogen).
Check that the peak height for m/z 28 (nitrogen) is not more than twice that for m/z 18 (water).

If the peak height for m/z 28 (nitrogen) is more than twice that for m/z 18 (water), it is possible that 
there is an air leak. Search for the location of the leak.

^ Reference
Refer to the System User's Guide for details on how to check for vacuum leaks.

5 Click (Filament ON/OFF) to turn OFF the filament.

5 Close the [Tuning] window.
The message [Save current tuning file?] is displayed. Click [No].

1

3

2,5

4
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2.7  Autotuning

2

2.7 Autotuning
Wait for approximately 2 hours (before starting qualitative analysis) or 4 hours (before starting 
quantitative analysis) after starting up the vacuum system and then perform autotuning using the 
procedures described below.

2.7.1 Setting Analysis Conditions
If no analysis conditions have been created, start from "2.7.2 Executing Autotuning" P.14.

If a method file is already created, parameters can be specified in the instrument according to the following 
procedure. 

However, parameters for an accessory or peripheral equipment, except for AOC-20 auto-injector/auto-
sampler, cannot be specified by using the following procedure.  When using an accessory/peripheral 
equipment, set the parameters on the equipment itself, or by using the software specific to that equipment/
device.

1 Click the [Data Acquisition] icon on the [Real Time] assistant bar. 
The [Acquisition] window opens.

2 Click (Open) on the toolbar. 



2  Starting GC/MS

14   GCMS-QP2010 Series Operation Guide

3 Select the method file to load, then click [Open]. 
The method file is loaded. 

4 Select [Download Initial Parameters] on the [Acquisition] menu.

If the message "The hardware configuration for this method is different from the current instrument 
configuration. The measurement condition in the method file is modified according to the current 
instrument configuration." appears, click [OK]. 

2.7.2 Executing Autotuning

1 Click the [Tuning] icon on the [Real Time] assistant bar.
The [Tuning] window opens.
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2.7  Autotuning

2

2 Click the [Peak Monitor View] icon on the [Tuning] assistant bar.
The [Peak Monitor] window opens.

3 Select [New Tuning File] on the [File] menu.

4 Select Tuning Mode appropriate for the application.
 (This feature applies to QP2010 Ultra and QP2010 SE models.) 
When creating a new tuning file, choose the tuning mode appropriate for the concentration level of target 
compounds being measured. Since the tuning file is created with an emission current corresponding to 
the selected mode, it enables measuring samples with an appropriate dynamic range. 
• QP2010 Ultra:High concentration (20 µA), standard (60 µA, default), or high sensitivity (150 µA)
• QP2010 SE:High concentration (20 µA) or standard (60 µA, default) 

5 Select the filament to be used.
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6 Click the [Start Auto Tuning] icon on the [Tuning] assistant bar.

7 Enter a file name and click [Save] to start autotuning.
When autotuning is completed, a report is printed.

8 Close the [Tuning] window.
The message [Save current tuning file?] is displayed. Click [Yes].
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2.7  Autotuning

2

2.7.3 Checking Autotuning Results

1 Check the results of autotuning.

1 Check that the FWHM (full width at half maximum) values are in the range 0.5 to 0.7.
2 Check that the detector voltage does not exceed 2 kV.
3 Check that the base peak values are 18 or 69.
4 Check that the relative intensity ratio for m/z 502 is at least 2 % (for QP2010S and SE : 1 %).
5 Check that the peak intensity for m/z 69 is at least twice that for m/z 28.

If any irregularities are discovered above, possible causes could include a vacuum leak, poor 
column connections, or contaminated ion source. 

See "Appendix D Maintenance" P.83 to implement corrective measures. 

2

1

3

45
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3 3Creating a Folder

3.1 Creating a Folder with Data Explorer

1 Click the [Data Acquisition] icon on the [Real Time] assistant bar.
The [Acquisition] window opens.

2 Click (Data Explorer) on the toolbar to display Data Explorer.

3 Click (Project (Folder) Selection).
The [Project (Folder) Selection] window opens.



 GCMS-QP2010 Series Operation Guide   19

3.1  Creating a Folder with Data Explorer

3

4 Click the GCMSsolution folder in the C drive in Data Explorer and click [New Folder].
The [Create New Folder] window opens.

5 Type a folder name and click [OK].
A folder is created in the GCMSsolution folder in the C drive and the [Project (Folder) Selection] window 
returns.

6 Click [Close].
To select an existing folder, see "Appendix C Using Data Explorer" P.81. 



20   GCMS-QP2010 Series Operation Guide

4 4Qualitative Analysis

4.1 Creating a Method File
Set the instrument (i.e., autosampler, GC, MS) parameters and similarity search parameters using the 
procedure described below.

Use default values for parameters that are not covered by the following explanations.

1 Click the [Data Acquisition] icon on the [Real Time] assistant bar.
The [Acquisition] window opens.

2 Select [New Method File] on the [File] menu.



 GCMS-QP2010 Series Operation Guide   21

4.1  Creating a Method File

4

4.1.1 Setting Autosampler Parameters

1 Click the [Sampler] tab and specify the number of rinses appropriate for the sample. 

4.1.2 Setting GC Parameters

1 Click the [GC] tab and set the analysis conditions.

1 Input an initial temperature for the column oven (40 to 100 °C).
2 Input an injection temperature based on consideration of the boiling point of the target compound 

(200 to 300 °C).
3 Select [Split] or [Splitless].

7

1 2 3

4

6 5
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Selecting Injection Mode

• Split:  Select this mode if the concentration of the target compound is high.  As a rough 
guideline, select this mode when the target compound concentration is greater than 
10 ng/uL.

• Splitless:  Select this mode if the concentration of the target compound is low.  As a rough 
guideline, select this mode when the target compound concentration is less than 
10 ng/uL.

4 Select [Pressure] when the method calls for a constant pressure mode, and select [Linear Velocity] 
when the method calls for a constant linear velocity mode for the carrier gas.  When no reference 
method is available, select [Linear Velocity].

5 When no reference method is available, refer to the table "Typical Pressure Settings for Carrier Gas" 
to set an initial value for the pressure.  The linear velocity will be set automatically.

Typical Pressure Settings for Carrier Gas

6 If "Split" is selected as the injection mode, enter a split ratio. If "Splitless" is selected, enter "-1.0".
7 Set appropriate conditions for separating the target compound from other peaks. 

4.1.3 Setting MS Parameters

1 Click the [MS] tab and set the analysis conditions.

1 Input [Interface Temp.] (200 to 300 °C).
2 Input [Start Time] and [End Time] according to the note below.  

Middle bore capillary column
(I.D. 0.25 mm)

Semi-wide bore capillary column
(I.D. 0.32 mm)

30 m 60 m 30 m 60 m
75 to 150 kPa 100 to 250 kPa 30 to 50 kPa 50 to 100 kPa

5

1

64

3

2

[GC Program Time] value
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4.1  Creating a Method File

4

In the absence of information about the elution time of the solvent peak, set [Start Time] to zero 
minutes, and set [End Time] to the [GC Program Time] value. After one analysis of a standard 
sample or the solvent, and obtaining the solvent peak profile, change the [Start Time] to a time 
after the end of the solvent peak (see the figure shown on page 23).

3 Click [Relative to the Tuning Result]. 
If peak intensity is too low, change the value within the range +0.1 to +0.3., as necessary. 

4 Input a value that is 0.5 minutes less than the [Start Time] setting. (If the resulting value is less than 
zero, enter "0".) 

Relationship between Start Time and Solvent Elution Time

5 Select [Scan].
6 Enter the mass range to be measured, where [Start m/z] is the lower mass limit, and [End m/z] is the 

upper mass limit.  The typical value for [Start m/z] is 35, and the typical value of [End m/z] is the 
highest molecular weight of the target compounds in the sample plus some margin of error (+15).

4.1.4 Setting Similarity Search Parameters

1 Select [Qualitative Parameters] on the [Method] menu.
The [Qualitative Parameters] window opens.

Solvent peak

GC START

Solvent elution time (Detector ON)

Start time

TIC

Peak of target compound
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2 Click the [Similarity Search] tab and set the search conditions.

1 Click .
The [Open File] window opens.

Open the library to be used.
2 To remove a library from the selection, highlight the library file name by dragging the mouse over it, 

then press the [Delete] key. 
3 Select [Do not include duplicate hits].
4 After completing the settings, click [OK] to return to the original window.

1

2

3

4
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4.2  Repeating Autotuning

4

4.1.5 Saving the Method File

1 Select [Save Method File As] on the [File] menu.

2 Enter a file name and click [Save].

4.2 Repeating Autotuning
If autotuning has not been performed under the analysis conditions, perform the procedures described 
under "2.7 Autotuning" P.13.
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4.3 Sequential Analysis
Create a batch file necessary for qualitative analysis and perform sequential analysis using the 
procedures described below. 

4.3.1 Creating a Batch File
To use an existing batch file, follow the procedure starting in"4.3.2 Editing a Batch File ^  Ver. 2.5" 
P.29. 

1 Click the [Batch Processing] icon on the [Real Time] assistant bar.
The [Batch Table] window opens.

2 Select [New Batch File] on the [File] menu.
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4.3  Sequential Analysis

4

3 Click the [Wizard] icon on the [Batch] assistant bar.
The [Batch Table Wizard] window opens.

4 With the Batch Table Wizard, make the appropriate settings and create a batch table.

1 Click [New].
2 Click [Unknown Only].

3 Click and specify the method file to be used.
4 Deselect both [Data Processing] items.
5 Click [Next].

3

2

1

4

5
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6 Input [Vial #] and [Sample Count].
7 Input [Injection Volume].
8 Click [Next].

9 Enter [Data File Name].
If the file name ends with a number, the files are named sequentially.

10 Click [Finish]. The batch table is displayed.

7
6

8

9

10
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4.3  Sequential Analysis

4

4.3.2 Editing a Batch File  ̂ Ver. 2.5 
For routine analyses, it may be more convenient to partially edit and execute existing batch files. 
The following procedures describe how to edit information in specified row(s) collectively. 

1 Double-click the batch file to be edited. 

2 Add or delete rows depending on the number of samples being analyzed. 

1 Click on the row number to be edited to highlight the whole row.  Multiple rows can be selected by 
dragging the mouse over multiple row numbers. 

2 Right-click on the selected row, and select the appropriate editing command from the menu that is 
displayed.

In addition, rows can be added easily by repeatedly entering "1" as the vial number and pressing the 
down arrow key on the keyboard. 

Menus Explanation
Copy Row Copies the selected row. 
Add Row Adds a row to the end.
Insert Row Inserts a new row above the selected row. 
Paste Row Pastes the copied row. 
Delete Row Deletes the selected row. 
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The following steps can be performed to quickly copy the contents of one row onto several rows, or to fill 
in the contents of several rows quickly.  Serial numbers will be added to the end of the sample name and 
data file name, for examples, in the edited rows.

3 Edit the vial number, sample name and data file name in an existing row, which is to be 
the first of several rows to be edited.  

1 Directly enter the vial number and sample name.  Add a number at the end of sample name. 
2 To set the data file name, click within the cell, then click the arrow buttons that appear. 

The [Select Data File] window opens. 
Directly enter the data file name in the [Select Data File] window, then click [Open]. 

It is not necessary to type file extensions when entering data file names. 

3 To set the method file, click within the cell, then click the arrow buttons that appear. 
The [Select Method File] window opens. 
Select the method file to use. 
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4.3  Sequential Analysis

4

4 Drag the mouse from the edited row to the row specified with serial numbers. 

To collectively edit specified cells, without changing other settings, drag the mouse across the cells 
to edit and perform the operation described in step 6. 

For example, this can be used to edit the vial numbers and data file names for standard samples 
used to create calibration curves (for quantitative analysis).

5 Select [Fill Down] on the [Edit] menu. 
The entire content of the first row is copied. 

6 Select [Fill Series] on the [Edit] menu. 
Edited parameters will be appended with serial numbers. 
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4.3.3 Saving Batch Files 

1 Select [Save Batch File As] on the [File] menu.

2 Open the folder where the method file is saved, enter a name, and save the file.
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4.3  Sequential Analysis

4

4.3.4 Executing Sequential Analysis 

1 Set the syringe rinse solvent and samples in the autosampler. 

2 Click the [Start] icon on the [Batch] assistant bar. 
Analysis starts. 

• To abort batch processing, click the (Stop) icon on the [Batch] assistant bar.

• To modify or add batch files while analysis is in progress, see "Appendix H Editing and Adding 
Batch Files During Sequential Analysis" P.99. 

• To execute only specified rows, select the rows by clicking or dragging the mouse, then start the 
analysis. 
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4.4 Analyzing Data
Use the procedure described below to perform basic qualitative data processing for data measured in 
Scan mode, for examples, to display mass spectra, perform background subtraction, and perform 
similarity search.

1 Double-click the (GCMS Postrun Analysis) icon.

The [GCMS Postrun Analysis] program starts.

2 Click the [Qualitative] icon on the [Postrun] assistant bar.

4.4.1 Loading Data Files

1 With reference to "Appendix C Using Data Explorer" P.81, double-click the data file to be 
analyzed.
The data file to be analyzed opens.
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4.4  Analyzing Data

4

4.4.2 Zoom in on a Peak in the Chromatogram and Displaying Mass 
Spectra

1 Specify a range in the TIC window by dragging the mouse so that both the peak top and 
baseline are highlighted. 
Drag the mouse so that both the peak top and baseline are displayed.

The top window displays the full chromatogram, and the second window displays any enlarged portion of 
the same chromatogram.

To undo the zoom, right-click in the MC window and select [Undo Zoom] on the pop-up menu.

An enlargement of 
the range specified 
by dragging is 
displayed in the 
MC window.

TIC window

MC window
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2 Move the mouse pointer to the peak top and double-click.
The mass spectrum for the peak top is displayed.

If a mass spectrum location other than the peak top is displayed, align the bar position with the peak top 

by clicking .

If a red peak appears in the mass spectrum, it indicates that the signal intensity for this m/z has 
exceeded the scale. To display the proper mass spectrum for target compounds, click the left or right 

arrow buttons to select a mass spectrum that shows no red peaks.

Click here
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4.4  Analyzing Data

4

4.4.3 Removing the Background 
The mass spectrum corresponding to a peak in the chromatogram has a contribution from the background. 
This background mass spectrum may interfere with the subsequent qualitative analysis, hence it needs to 
be subtracted from the compound’s mass spectrum. The steps shown in this section describe the 
procedure for removing the background mass spectrum from a compound’s mass spectrum.

1 Click (Spectrum Subtraction) on the toolbar and position the mouse pointer in the 
MC window.
A bar is displayed.

2 Double-click at the background processing position (see NOTE below).
The target spectrum, from which the background spectrum has been subtracted, is displayed.

With the following types of peaks, process the parts indicated by arrows as background. 

The background 
processing position.

Example 1) Example 2) Example 3)

Background spectrum can 
be subtracted from one of 
positions.
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4.4.4 Searching for Similarity ^ Ver. 2.5

1 Click the [Similarity Search] icon on the [Qualitative] assistant bar. 
The [Similarity Search Results] window opens.

2 Click the buttons on the left of the mass spectra as appropriate and check the mass 
spectra for the compounds found.

No. Explanation
1 Similarity: The closer this value is to 100, the greater the similarity in mass spectra.

2 To enter a compound name in the spectrum table, select the box for the applicable compound.

3 Hit numbers for the compounds found.

4 Use to switch between the mass spectra for the compounds found.

1 2

4

Spectrum 
Display 

Mass Spectra of 
Searched Compounds  

3
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4.4  Analyzing Data

4

3 After checking the mass spectra, click (Register Target Spectrum to Spectrum 
Process Table).
The mass spectrum is registered. 

Registering identification results in the spectrum process table allows referencing those results at a 
later time or outputting them as a report. 

4 Close the [Similarity Search Results] window. 

4.4.5 Displaying Mass Chromatograms 
In the following situations, displaying mass chromatograms (MC) makes it easier to analyze the data. 
For instructions of how to display mass chromatograms, see "Appendix G Displaying 
Chromatograms" P.96. 

Confirming the Purity of Peaks 
Displaying mass chromatograms can be used to check the presence of two or more overlapping peaks, or 
in other words, to check the purity of a peak in the chromatogram. 
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Looking for Target Compound Peaks Among Multiple Peaks 
In some cases, peaks for target compounds cannot be confirmed in a total ion chromatogram (TIC). 

If characteristic mass spectral peaks (i.e., m/z) of the target compounds are known, displaying the mass 
chromatograms makes it easier to check the position of the target compound's peaks in the chromatogram.

If characteristic spectral peaks are not known for the target compounds, see "Appendix F Index Searches" 
P.94 to check the mass spectra of target compounds. 

4.4.6 Registering Spectra Displayed for Target Compounds
^  Ver. 2.5

1 Register all the other target compounds using the procedure described in "4.4.2 Zoom 
in on a Peak in the Chromatogram and Displaying Mass Spectra" P.35.

4.4.7 Editing the Spectrum Process Table

1 Click the [Qualitative Table] icon on the [Qualitative] assistant bar.
The [Qualitative Table] window opens.
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4.4  Analyzing Data

4

2 Click (Maximize).

3 Double-click the first row in the spectrum table.
The [Similarity Search Results] window opens.

4 Click the buttons on the left of the mass spectra as appropriate to double-check the 
mass spectra for the compounds found. 

No. Explanation
1 Similarity: The closer this value is to 100, the greater the similarity in mass spectra.

2 To enter a compound name in the spectrum table, select the box for the applicable compound.

3 Click to copy the selected compound names to the spectrum table.

1

5

4

2 3

6
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5 After checking the mass spectra, close the [Similarity Search Results] window.

6 To edit compound names or other information in the spectrum process table, click the 
desired row, then select the [Edit] menu. 

7 Close the [Qualitative Table] window.

4.4.8 Saving Data Files 

1 Click (Save) on the toolbar.
The qualitative table is saved in the data file.

4 Use to switch between the mass spectra for the compounds found.

5 Hit numbers for the compounds found.

6 Allows switching between search results for each row in the spectrum process table. 

No. Explanation
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4.5  Printing Qualitative Analysis Reports

4

4.5 Printing Qualitative Analysis Reports 
The procedures are described below on how to use a template to create a report of analyzed data, 
how to edit the area of the chromatogram to display in the report, and how to edit the number of 
compounds to be displayed in the report of similarity search results. 

4.5.1 Loading Report Formats 

1 Click the [Report] icon on the [Qualitative] assistant bar.
The [Data Report] window opens. 

2 Click [New Format File] on the [File] menu. 
The [File New] window opens. 

3 Select [Use Template] and select the format [Qualitative Analysis Report]. 

4 Click [OK]. 
The [Qualitative Analysis Report] format opens. 
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4.5.2 Editing Report Formats 

1 Double-click on the chromatogram. 
The [GCMS Chromatogram Properties] window opens. 

2 Click the [Chromato] tab. 
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4.5  Printing Qualitative Analysis Reports

4

3 In the [Area] area, deselect [Auto] for the X-axis and enter the time range. 

4 Click [OK]. 

5 Click the next page icon on the toolbar to display the second page. 

6 Double-click on the [Library] display item. 
The [GCMS Library Properties] window opens. 
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7 Click the [Result] tab. 

8 Enter the [Maximum Compound Number] (maximum number of search results to 
display). 

9 Click [OK]. 
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4.5  Printing Qualitative Analysis Reports

4

4.5.3 Outputting Reports

1 Click the [Preview] icon on the [Data Report] assistant bar. 
The print preview window opens. 

2 After checking the report content, click [Print] to print the report. 

3 Click (Save) on the toolbar. 
The report is saved as part of the data file. 
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5 5Quantitative Analysis

5.1 Creating a Method File
With reference to"4 Qualitative Analysis" P.20, analyze standard samples and register the retention 
times and mass spectra of the target compounds in the spectrum process table. 

5.1.1 Creating a Compound Table

1 Start the [GCMS Postrun Analysis] program and click the [Compound Table] icon on the 
[Postrun] assistant bar.
The [Create Compound Table] window opens.

2 From Data Explorer, double-click the data file in which the spectrum process table for 
the target compounds was saved.

3 Click the [Wizard (New)] icon on the [Compound Table] assistant bar.
The [Compound Table Wizard] window opens.
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5.1  Creating a Method File

5

4 Select [Use current Spectrum Process Table] and then click [Next].

5 Click [Next].

6 Select a row in the table, check the mass spectrum for each compound, and click [Next].



5  Quantitative Analysis

50   GCMS-QP2010 Series Operation Guide

7 Specify the calibration curve type, the quantitative method, and other parameters as 
required, and click [Next].

No. Item Explanation
1 Quantitative 

Method
• External Standard:Quantitation is performed using a calibration curve 

obtained from the absolute quantity (concentration) and the area or height 
value of the target compound in a standard sample.

• Internal Standard:An internal standard is added to the sample, the sample is 
analyzed, and quantitation is performed using the relationship between the 
relative sensitivity and the quantitative ratio with respect to the internal 
standard compound.

2 Calculated by Select [Area] or [Height]. Normally, select [Area].
3 # of Calib. Levels Input the number of concentration levels of the calibration curve. 
4 Unit Set the concentration unit used for reports.
5 Format of 

Concentration
Set the number of digits used to indicate concentrations.

5

4

1

3 2
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5.1  Creating a Method File

5

8 Make the appropriate settings for concentrations and measurement ions, and click [Next].

9 Set the type, compound name, target ion, and reference ion for each substance. After 
entering the required information for all the compounds, click [Next]. 

1 Select [Target] in the [Type] list.
Select [I.S.] when setting for an internal standard.

2 Change the type and m/z value. 

No. Item Explanation
1 Standard Set the concentrations of the standard samples. If the concentration varies with the 

compound, make the necessary corrections after completing the wizard procedure.
2 Internal Standard Set the concentration of the internal standard. 
3 # of Reference 

Ions
Input the number of reference ions used to perform peak identification.

4 Decimal for mass Determine the number of decimal places for target ion and reference ion m/z values. 
Selecting [1 Decimal] increases the sensitivity level. 

1

2

3

4

2

4 1

3
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• To change the type, click cell for the type to be changed and select "Target Ion", "Ref. Ion", or "Not 
used". 

• To change the m/z value, click the cell for the m/z value to be changed and click the arrow button 
that appears. 
The mass spectrum is displayed. To set the m/z value, enlarge the area near the spectrum peak 
to be set by dragging the mouse and double-click on the spectrum peak. Switching the compound 
ID number also switches the mass spectrum. 

3 The names registered in the spectrum table are entered automatically. If there are blank spaces, 
enter the compound names.

4 Change the compound displayed by changing the ID number. 

10 Click [Finish].
A compound table is created. Correct the contents of the compound table as required.

To correct the compound table, enter edit mode by clicking at the top-right corner of the 

table. When editing is completed, return to display mode by clicking .

11 Click the [Save Compound Table] icon on the [Compound Table] assistant bar.
The method file that was used to acquire the data will be selected automatically.
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5.1  Creating a Method File

5

12 Click [Save].

If greater sensitivity is required, use the following procedure to create a quantitative analysis method 
for the SIM mode. 

This completes the procedure for creating a quantitative method for Scan mode.

5.1.2 Creating a SIM Table

1 Click the [Create SIM Table [COAST]] icon on the [Compound Table] assistant bar.
The [Select Method File] window opens.

2 Enter a file name and click [Save].
The [Create SIM Table [COAST]] window opens.

3 Click (Maximize) in the [Creation of Automatic SIM (Scan/SIM) Table [COAST]] 
window. 
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4 A SIM table is created automatically.  Check the chromatogram and SIM table and, if 
necessary, modify the table with reference to the following procedure.

Modification Procedure 
To ensure sufficient sensitivity, it is best to specify no more than 20 m/z values per row (i.e. per group). 
If necessary, modify the SIM table. 

• To edit table rows (i.e. groups), right-click on the desired row and select the following on the menu 
that appears. 

• Add Row : Adds a row to the bottom of the table. 

• Insert Row : Inserts a new row above  the selected row. 

• Delete Row : Deletes the selected row. 

• To undo enlarging the chromatogram, right-click on the chromatogram and select [Undo Zoom]
on the menu that appears. 

• To split groups, use the following procedure. (Example: Splitting Group 3 into two groups) 

1. Click the third row of the SIM table. 
2. Right-click on the table and select [Insert Row]. 
3. Click the inserted row and drag the mouse on the chromatogram to specify and enlarge the 

desired area. 
4. Click near the center of peaks labeled with compound names. 

Group 3 is divided into two groups. 

No. Item Operation
1 Start Time Click within the frame next to [Start Time], then point the mouse 

pointer to the location on the chromatogram corresponding to the time 
when data acquisition is to be started, then click the left mouse button.
Normally start time is set 0.5 to 1 minute before elution of the first 
target compound. 

2 End Times and m/z Values for 
Each Group 

Click the target row (i.e. group) and drag the mouse on the 
chromatogram to specify and enlarge the desired area. 
Next, click near the center of peaks labeled with compound names to 
specify the measurement end time for that group. This automatically 
sets the corresponding m/z values for the group at the same time. 

2

1
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5.2  Sequential Analysis

5

5 When finished, click [OK]. 
A method is created for SIM mode quantitative analysis. 

5.2 Sequential Analysis
Create a batch file necessary for quantitative analysis and perform sequential analysis using the 
procedure described below. 

5.2.1 Creating a Batch File 
To use an existing batch file, follow the procedure starting in "5.2.2 Editing a Batch File ^ Ver. 2.5" P.58. 

1 Start the [GCMS Real Time Analysis] program and click the [Batch Processing] icon on 
the [Real Time] assistant bar.
The [Batch Table] window opens.

2 Select [New Batch File] on the [File] menu.

3 Click the [Wizard] icon on the [Batch] assistant bar.
The [Batch Table Wizard] window opens.
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4 Make the appropriate settings with the Batch Table Wizard and thereby create a batch 
table.

1 Select [New].
2 Select [Standard & Unknown].

3 Click and specify the method file to be used.
4 Select [Quantitative].
5 Click [Next].

6 Input [Vial #].
The number of calibration points is loaded automatically from the method.

7 Input [Injection Volume].
8 Input [Average Count] (i.e., the number of repetitions).
9 Click [Next].

1

5

2

3

4

6

9

8
7
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5.2  Sequential Analysis

510 Enter [Data File Name].
If the file name ends with a number, the files are named sequentially.

11 Click [Next].

12 Input [Vial #].
13 Input [Sample Count].
14 Input [Injection Volume].
15 Click [Next].

11

10

12

15

13
14
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16 Enter [Data File Name]. 
If the file name ends with a number, the files are named sequentially.

17 Click [Finish]. 
The batch table is displayed.

5.2.2 Editing a Batch File ^ Ver. 2.5 

1 To edit a batch file, see "4.3.2 Editing a Batch File ^  Ver. 2.5" P.29. 

5.2.3 Saving Batch Files 

1 Select [Save Batch File As] on the [File] menu.

16

17
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5.2  Sequential Analysis

5

2 Open the folder where the method file is saved, enter a name, and save the file.

5.2.4 Executing Sequential Analysis 

1 Set the syringe rinse solvent and samples in the autosampler. 

2 Click the [Start] icon on the [Batch] assistant bar. 
Analysis starts. 

• To abort batch processing, click the (Stop) icon on the [Batch] assistant bar.

• To modify or add batch files while analysis is in progress, see "Appendix H Editing and Adding 
Batch Files During Sequential Analysis" P.99. 

• To execute only specified rows, select the rows by clicking or dragging the mouse and start the 
analysis. 
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5.3 Analyzing Data

5.3.1 Checking and Correcting Calibration Curves

1 Start the [GCMS Postrun Analysis] program and click the [Calibration Curve] icon on the 
[Postrun] assistant bar.
The [Calibration Curve] window opens.

2 Double-click the method file used in analysis from Data Explorer.
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5.3  Analyzing Data

5

3 Select a compound in the compound table and click the calibration curve level. 
Check the calibration curve created and the chromatogram.

^ Reference
 If no peaks are identified or detected, perform identification or peak integration with reference to 
"Manual Identification and Manual Peak Integration" P.63.

To change the method used to plot calibration curves, see "Changing Parameters for Quantitative 
Processing" P.65. 

Peaks that are detected in the chromatograms after automatic peak integration, will have peak 

detection marks ( ).

The detected peaks are subjected to identification based on the retention times and ion ratios 

( peak identification mark).

Peak identification mark

Peak detection marks
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4 Only after correcting the calibration curves, click (Save) on the toolbar to save the 
method file.

Chromatogram Countermeasure
No peaks are detected. Perform manual peak integration.

Peaks are detected but different peaks are identified. Perform manual identification.

Peaks are detected and identified but peak integration is not performed 
properly.

Perform manual peak integration.



 GCMS-QP2010 Series Operation Guide   63

5.3  Analyzing Data

5

Manual Identification and Manual Peak Integration
If no peaks are identified or detected, perform identification or peak integration using the procedure 
described below.

Manual Identification

1 Right-click in a chromatogram and select [Manual Identification] from the displayed 
menu.
A bar is displayed.

2 Click the top of the peak to be identified.
The peak is identified.
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Manual Peak Integration

1 Right-click in a chromatogram and select [Manual Peak Integrate…] from the displayed 
menu.
A bar is displayed.

2 Drag the mouse from the start point to the end point of the peak.
The [Base Line] window opens.
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3 Select the baseline and click [OK].
The peak is integrated and identified.

The same process can be accomplished by performing the following operations on the 
chromatogram.

Changing Parameters for Quantitative Processing
Change quantitative processing parameters as necessary. 

1 Click the [Quantitative Parameters] icon on the [Calibration] assistant bar. 
The [Quantitative Parameters] window opens.

2 Click the [Quantitative] tab. 

Process Operation Explanation
Manual Identification [Shift] + [Ctrl] + right-click Identifies integrated peaks. 
Manual Peak Integration [Shift] + right-click-drag Connects start point and end point as 

baseline. 
Manual Peak Integration [Ctrl] + right-click-drag Connects points with horizontal baseline. 



5  Quantitative Analysis

66   GCMS-QP2010 Series Operation Guide

3 Change the [Curve Fit Type], [Zero], and [Weighted Regression] settings, as necessary. 

4 After finishing making changes, click [OK]. 
Calibration curves are corrected according to the changed parameters. 

No. Name Explanation
1 Curve Fit Type Specifies how to plot the calibration curve. 

• Linear: Determines the calibration curve as a straight line from the obtained 
values. 

• Point to point: Points are connected by a broken line. No formula is displayed 
for point to point calibration curves. 

• Quadratic: Curve is fit to each point using a quadratic equation. This requires 
at least three points on the calibration curve. For two points or less, the curve 
is calculated as linear. 

• Mean RF: First, it determines straight lines passing through the origin and 
each point. Then it finds the simple average of the slopes for each line. 
Consequently, the resulting calibration curve always passes through the 
origin. 

2 Zero Select either [Not Forced] or [Force Through]. Normally, select [Not Forced]. 
3 Weighted 

Regression
A typical least squares method of plotting calibration curves could result in a 
quantitation error that is larger the lower the concentration at the calibration point. In 
general, when the calibration curve has a large dynamic range (maximum 
concentration is at least 50 times higher than the minimum quantitation limit), 
formulas are weighted to reduce the weight of higher concentration points of the 
calibration curve. Typically, formulas are optimized by checking the correlation 
coefficient and contribution ratio. 

• [1/C2]: Formulas are weighted by the inverse of the concentration value 
squared. 

• [1/C]: Formulas are weighted by the inverse of the concentration value. 
• [1/A2]: Formulas are weighted by the inverse of the area value squared (or 

height value when a height is specified for the data used). 
• [1/A]: Formulas are weighted by the inverse of the area value (or height value 

when a height is specified for the data used). 

3

2

1
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5.3.2 Re-quantifying after Correcting a Calibration Curve
After correcting a calibration curve, re-quantify the data for samples with unknown concentrations. 

1 Click the [Batch Processing] icon on the [Postrun] assistant bar.
The [Batch Table] window opens.

2 Select [New Batch File] on the [File] menu. 

3 Click the [Select Data File] icon on the [Batch] assistant bar.
The [Select Data File] window opens.
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4 Click the data file for sample with unknown concentrations, for which re-quantification

is to be performed and click (Add).
The data file is selected. 

5 Click [OK].

6 A batch table is displayed. Assign a name to the batch file and save it.

7 Click the [Start] icon on the [Batch] assistant bar.
The data is re-quantified using the corrected calibration curve.
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5.3.3 Checking and Correcting Quantitation Results
Check the quantitation results for the samples with unknown concentrations. 

1 Click the [Quantitative] icon on the [Postrun] assistant bar.

2 Double-click the data file to be checked from Data Explorer.
The data file being checked opens. 

3 Click the [Results] tab in the [Compound Table View].
The quantitation results are displayed.
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4 Display the standard spectra sub-window and reference data sub-window in the 
[Quantitative View] area.
If necessary, see "Displaying Standard Spectra" P.72 ,"Displaying Reference Data" P.72 to display 
information about identified compounds. 

5 Click on a compound name in the compound table and check the chromatogram in the 
[Quantitative View].
Check the results while viewing the peak identification/detection marks and baseline in the 
chromatogram.

Reference Data 

Standard Spectrum 

Qantitative View
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^ Reference
If necessary, perform identification or peak integration with reference to "Manual Identification and 
Manual Peak Integration" P.63.

The same process can be accomplished more easily by performing the following operations on the 
chromatogram.

6 After checking the results, click (Save) on the toolbar.
The data file is saved.

When peaks are integrated for quantitation, concentrations calculated from the calibration curve are 
displayed. 

However, if quantitation fails, character strings other than concentration values are displayed 
according to the cause of failure, as described below.

Process Operation Explanation
Manual Identification [Shift] + [Ctrl] + right-click Identifies integrated peaks. 
Manual Peak Integration [Shift] + right-click-drag Connects start point and end point as 

baseline. 
Manual Peak Integration [Ctrl] + right-click-drag Connects points with horizontal baseline. 
Delete Identification 
Results

[Shift] + [Ctrl] + right-double-click Voids identification and removes 
quantitative calculation results. 

Displayed Character String Explanation
No peak is detected. Quantitative peak integration resulted in no peaks detected. 
No peak is found in Window/Band 
range.

No peaks were detected within the retention time range 
specified for identification. 

Ratio of reference ion does not match. Peak is not identified due to the difference between specified 
and measured reference ion ratio values exceeding the 
allowable range. 

Under the minimum similarity index. Peak is not identified due to the measured similarity being less 
than the specified similarity setting, when mass pattern 
matching is specified in identification parameters. 

No peak is identified. Automatic identification results were manually deleted. 



5  Quantitative Analysis

72   GCMS-QP2010 Series Operation Guide

Displaying Standard Spectra
Data can be analyzed more easily by comparing the displayed spectrum with a standard spectrum. 

1 Click [Spectrum View] on the [View] menu, then select [Display Standard Spectrum].
The standard spectrum is displayed. 

The standard spectrum is a mass spectrum of a standard sample registered when the compound 
table was created. 

The standard spectrum can be hidden by repeating step 1 above. 

When the measured spectrum is enlarged by dragging, the standard spectrum is enlarged 
correspondingly. 

Displaying Reference Data 
Compounds can be identified from the shape of chromatograms, retention times, and other information 
obtained by referencing measurement data of standard samples or spiked samples.

1 Select [Open Reference Data File] on the [File] menu to open the data file being 
referenced. 
The reference data is displayed. 
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2 Select [Close Reference Data File] on the [File] menu to specify the reference data file to 
close. 
The reference data file closes.

Up to three reference data files can be displayed. 

Reference data peaks cannot be integrated. 

5.4 Printing Quantitative Analysis Reports 

5.4.1 Creating and Outputting Quantitative Analysis Reports 

1 Click the [Report] icon on the [Quantitative] assistant bar. 
The [Data Report] window opens. 

2 Click [New Format File] on the [File] menu. 
The [File New] window opens. 
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3 Select [Use Template] and select the format [Quantitative Analysis Report]. 

4 Click [OK]. 
The [Quantitative Analysis Report] format opens. 

5 Click the [Preview] icon on the [Data Report] assistant bar. 
The print preview window opens. 
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6 After checking the report content, click [Print] to print the report. 

7 Click  (Save) on the toolbar. 
The report is saved as a data file. 
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6 6Shutting Down GC/MS

6.1 Vacuum System Shutdown

1 Click the [Vacuum Control] icon on the [Real Time] assistant bar.
The [Vacuum Control] window opens.

2 Click [Auto Shutdown].
The vacuum system shuts down.

3 When [Completed] is displayed, click [Close].
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6.2 Turning OFF the Power
Turn OFF the power by performing the procedure for turning ON the power in reverse.
If accessory/peripheral equipment is connected, switch OFF the accessory/peripheral equipment 
power last. 

^ Reference
See "2.1 Turning ON the Power" P.3 for details on how to turn ON the power.

1 Quit the [GCMS Real Time Analysis] program and all other programs that are running.

2 Turn OFF the power to the PC, printer, and display.

3 Turn OFF the power to the MS unit.

4 Turn OFF the power to the GC unit.
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A AFile Format

GCMSsolution uses the file formats described below.

File type Icon Extension File contents
Data file .qgd In addition to the raw data acquired (e.g., chromatograms and spectra), 

the following information is saved.
• Calculation results such as area values and concentrations
• Status information such as the oven temperature and error status at 

the time data is acquired
• Contents of method files used in analysis (including configuration 

settings used for analysis)
• Contents of report format file (when reports are output)
• Contents of batch files (when batch processing is performed)
• Contents of tuning file used in analysis

Method file .qgm Analysis conditions, peak integration parameters, compound tables, etc. 
are saved.
Because the configuration settings are saved when the method is edited, 
the configuration settings are checked when the method file is loaded to 
ensure that they agree with the current settings. Created calibration curves 
are also saved in the method file.

Report format 
file

.qgr The report format information used to output a report, such as layout 
information and detailed settings, is saved.
Once a report format file has been created, it can be used repeatedly to 
output reports of the same format.

Batch file .qgb Batch tables used to perform automatic sequential processing are saved.
The same files can be used in both the [GCMS Real Time Analysis] 
program and the [GCMS Postrun Analysis] program.

Tuning file .qgt The conditions used to perform instrument adjustment (tuning) and the 
tuning results are saved.

Library file .lib These files are used to register the compound information and spectral 
data used to perform similarity searches. 
The libraries consist of public libraries (e.g., NIST and Wiley) and private 
libraries.
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Appendix
BViewing Help

B.1 Viewing Help
If you do not know how to perform a procedure, refer to Help using one of the procedures described below.

B.1.1 Displaying Help from the Assistant Bar

1 Click the [Guide] icon on the assistant bar in a window to display explanations for that 
window.

B.1.2 Displaying Help from the Menu Bar

1 Click [Contents] on the [Help] menu displayed in the menu bar of a window to display 
the [GCMS Help window].

Searching from the [Contents] Tab

1 Double-click the applicable topic.



B   Viewing Help

80   GCMS-QP2010 Series Operation Guide

Searching from the [Index] Tab

1 Type the applicable word.
The topic that matches the word is displayed at the top.

2 Select the applicable topic and click [Display].
Details on the selected topic are displayed.

If there are multiple instances of the word, the [Topics Found] window opens. Select the 
applicable topic from the list displayed and click [Display].

Searching from the [Search] Tab

1 Type the applicable word and click [Search].
The search results are displayed. 

2 Select the applicable topic and click [Display].
Details on the selected topic are displayed.

B.1.3 Displaying Help with the F1 Key

1 Press the [F1] key on the keyboard.
Help for the open window is displayed.



GCMS-QP2010 Series Operation Guide   81

C

C
C
C
C
C
C
C
C
C
C
C
C
C
C
C

C

Appendix
CUsing Data Explorer

Using the data explorer function makes it easy to load files. 
For convenience, leave Data Explorer displayed at all times. 

No. Explanation
1

Click (Data Explorer) on the toolbar to open and close the [Data Explorer] window.
2

Click (Project (Folder) Selection) to open the [Project (Folder) Selection] window and then click the 
applicable folder.

3 Click [Close] to close the [Project (Folder) Selection] window.
4 Click a tab to display the file of the corresponding type.
5 Click a file name (6) to display the corresponding file information.
6 Double-click the appropriate file to load the data.

1

4

2 3

6

5
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[Create New Project (Folder)] can be used to copy files from the folder currently open in Data Explorer and to 
create new folders.

This creates a new folder at the same directory level as currently open in Data Explorer. 

Using this feature is especially useful in the following situation. 

Example:

Folder A

Quantitative Method File 
(calibration curve already created) 

Batch File

Data files for standard samples used to 
create calibration curves and samples 
with unknown concentrations 

Folder B

Quantitative Method File 
(calibration curve already created) 

Batch File

You want to use the same 
method file and batch file, 
but want to save the 
calibration curve. 

Create a new project from 
Folder A. 
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Appendix
DMaintenance

D.1 Maintenance
Replace or clean the consumable items and maintenance parts as necessary, referring to the [MS 
Navigator] window using the procedure described below.

1 Double-click the (GCMS Real Time Analysis) icon.
The [GCMS Real Time Analysis] program starts.

2 Select [Maintenance] on the [Help] menu.
The [MS Navigator] window opens.

3 Click on the instrument for which maintenance will be performed.
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4 Read the precautionary information carefully and then click the applicable item under 
the maintenance menu.
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5 Perform maintenance by following the instructions displayed on the screen.
Click an image to enlarge it. Click [Back] in the enlarged window to return to the original window.

To perform another maintenance item, click [Back] and repeat the procedure from step 3.
After completing maintenance, close the [MS Navigator] window.
After performing maintenance, reset the usage frequencies and usage times using the procedure 
described in "Appendix D.3 Reset Procedure for Usage Frequencies and Usage Times ^ Ver.2.5" 
P.87.

D.2 Easy sTop 
(Applicable to QP2010 Ultra and QP2010 SE models) 
Using Easy sTop allows replacing septa and glass inserts without stopping the vacuum system. 
Therefore, it significantly reduces the time required for stabilizing the system after replacement and 
eliminates the need for autotuning. 
To protect columns, Easy sTop keeps the temperature of the sample injection unit, column oven, and 
interface at 70 °C or below. Consequently, it can take about 30 minutes until glass inserts and septa 
can be replaced. 

1 Double-click one of the icons for consumables in the instrument monitor. 
The [Consumable] tab page opens in the [Monitor Settings] window. 
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2 Click [Easy sTop]. 
The [Easy sTop] window opens and the injection unit, column oven, and interface temperatures decrease. 
When each temperature reaches 70 °C or lower, the "Ready" status is displayed in the [Easy sTop] 
window. 

3 Click [Replace], then replace septa or glass inserts in the sample injection unit.
For replacement procedures, refer to the septum replacement procedure or insert replacement procedure 
in the [MS Navigator] window. 
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Clicking [Replace] stops the supply of carrier gas. 

If left in that state for extended periods, it could reduce column performance. Therefore, replace 
septa and inserts as quickly as possible. 

4 After replacement, click [Complete] in the [Easy sTop] window. 
If there is no air leaking in, the sample injection unit, column oven, and interface temperatures return to 
their previous temperatures before Easy sTop started. 

5 Reset the usage counter for the septum and glass insert. 
For instructions on how to reset usage counters, see the procedure on page 88, starting with step 3. 

D.3 Reset Procedure for Usage Frequencies and Usage 
Times ^ Ver.2.5
The GCMSsolution's instrument monitor keeps track of the usage frequencies and usage times of the 
consumable items. 
After replacing a consumable item or cleaning the ion source, reset the usage frequencies and usage 
times using the procedure described below.

1 Double-click one of the icons for consumables in the instrument monitor. 
The [Consumable] tab page opens in the [Monitor Settings] window. 
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2 Click [Reset Consumables].
The [Reset Consumables] window opens.

3 Click [Clear] for the consumable items subjected to maintenance or input "0" in the 
usage time cells as appropriate, and click [OK].
The previous window returns.

4 Click [OK] in the [Monitor Settings] window.
The window closes.
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D.4 Changing Replacement Guidelines for septa and 
Glass Inserts
For septa, replacement frequency varies depending on the syringe needle diameter. 
Glass insert replacement frequency varies depending on the sample. Set replacement guidelines 
based on the sample. 

1 Click the [System Configuration] icon on the [Real Time] assistant bar. 
The [System Configuration] window opens.

2 Double-click [SPL1] under [Modules Used for Analysis]. 
The [Modules of Analytical Line #1] window opens. 
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3 Click [Injection Port Maintenance]. 
The [Injection Port Maintenance (SPL1)] window opens. 

4 Input [Septum Used Counts] and [Insert Used Counts] settings.
To restore default settings, click [Default]. 

5 Click [OK]. 
The [Modules of Analytical Line #1] window returns. 

6 Click [OK]. 
The [System Configuration] window returns. 
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7 Click [Set].

The replacement guidelines for septa and glass inserts are changed. 
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E ESingle Analysis 
(Manual Injection)

Use the procedure described below when analyzing samples one-by-one using the autosampler or 
when performing analysis using manual injection.

1 Start the [GCMS Real Time Analysis] program, then click the [Data Acquisition] icon on 
the [Real Time] assistant bar. 
The [Acquisition] window opens.

2 Double-click the method file to be used in Data Explorer. 

3 Click the [Sample Login] icon on the [Acquisition] assistant bar.
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The [Sample Login] window opens.

1 Enter [Sample Name] and [Data File].
2 When using an autosampler, input [Vial #] in which the sample is set and [Injection Volume].
3 Click [OK].

4 When using an autosampler, set syringe rinse solvent and samples in the specified 
positions. 

5 Click the [Download] icon on the [Acquisition] assistant bar.
The method file settings are transferred to the instrument.
When preparation for GC and MS has been completed, the [Start] icon turns green, indicating that it can 
be selected.
If using autosampler model AOC-20i, the analysis starts automatically. 

6 Inject the sample and press the [START] button on the keyboard at the GC unit.

If using accessory/peripheral equipment, start such equipment first, then click the (Start) icon.

To abort analysis before completion, click the (Stop) icon on the [Acquisition] assistant bar.

2

3

1



Appendix

94   GCMS-QP2010 Series Operation Guide

F F Index Searches

It is possible to search for information related to the target compounds (e.g., spectra and information 
on the structure) in the library.

1 Click the [Library Editor] icon on the [Postrun] assistant bar.
The [Library Editor] window opens. 

2 Click [Open Library] on the [File] menu to open the library to be used.
The library opens. 

3 Click the second row cell in the [Index] column to select an item. 

4 Enter information for the index item in the [Parameter] column for the row where the 
index item was selected. 
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5 Click [Start] on the [Index Search] menu.
The results are displayed.
Add index items until the target compound is found.

6 Confirm the applicable information (e.g., spectrum or structure).
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G GDisplaying 
Chromatograms

Displaying the appropriate mass chromatogram while analyzing data for qualitative analysis makes 
analysis easier. 
If the m/z value for which the chromatogram is to be displayed is not known, search for it beforehand 
using the procedure described in "Appendix F Index Searches" P.94.

G.1 Displaying Chromatograms from Fragment Tables

1 Click the [Fragment Table] icon on the [Qualitative] assistant bar.
The [MC Fragment Table] window opens.

2 Enter the applicable values in the [m/z] and [Factor] columns, select the corresponding 
cells in the [Disp.] column, and click [OK].
A mass chromatogram is displayed in the MC window.
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The display can be changed as shown below by enabling/disabling [Base Shift] in the table.
• With Base Shift

• Without Base Shift
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G.2 Displaying Chromatograms from Mass Spectra

1 In the mass spectrum, specify and enlarge the range containing the desired peaks by 
dragging the mouse. 

2 Move the mouse pointer to the spectral peak to be displayed and double-click. 
A mass chromatogram is displayed in the MC window, enlarged by an automatically set enlargement rate. 

• To hide the mass chromatogram, deselect the applicable cell in the [Disp.] column in the [MC 
Fragment Table] window. 

• To undo enlarging, right-click on the mass spectrum and select [Undo Zoom] on the menu that 
appears. 
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Appendix HEditing and Adding Batch Files 
During Sequential Analysis

During sequential analyses, the batch file being executed can be edited while the analysis is still in 
progress. In addition, a separate batch file can be added for processing after the current batch file is 
finished, by specifying a batch queue. 

H.1 Editing Batch Files 

1 Click on the batch table, then after the window switches, click the [Pause/Restart] icon 
on the [Batch] assistant bar. 
The [Batch Table] window opens, allowing unexecuted rows to be edited. 

Analysis of rows currently being analyzed will continue to be executed. 

When analyses are in progress, 
both the [Batch Table] window and 
[Acquisition] window are 
displayed. To switch to the [Batch 
Table] window, click on the table.
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2 Edit the batch table. 
Right-click on the row to be edited, then select [Add Row], [Delete Row], or other action on the menu that 
appears.
The vial number, data file name, or other information can be changed as well. 

3 Click (Save) on the toolbar. 

4 Click the [Pause/Restart] icon on the [Batch] assistant bar. 
The analysis restarts.

Some accessory/peripheral equipment may prevent using this function. 
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H.2 Adding Batch Files (Batch Queue)

H.2.1 Creating Batch Files to Add

1 Double-click the  (GCMS Analysis Editor) icon. 
The [GCMS Analysis Editor] program starts. 

2 Click the [Batch Processing] icon on the [Real Time] assistant bar. 
The [Batch Table] window opens.

3 Create the batch file to be added. 
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4 Name and save the batch file. 

5 Quit the [GCMS Analysis Editor] program. 

• The analysis will not start if the same data file name is used more than once or the specified 
method file does not exist. 

• The batch queue is not activated until the [GCMS Analysis Editor] program is closed. 

H.2.2 Adding Batch Files 

1 Start the [GCMS Real Time Analysis] program. 
During analysis, both the [Acquisition] and [Batch Table] windows are displayed simultaneously. 

[Batch Table] Window 

[Acquisition] Window
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2 Click the [Batch Table] window. 
The content of the toolbar, menu bar, and assistant bar changes. 

3 Select [Batch Queue] on the [Batch] menu. 
The [Batch Queue] window opens. 
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4 Click [Add] to open the batch file to be added. 

5 If multiple batch files were added, change their order by clicking to select the desired 
batch file, then clicking [Move Up] or [Move Down]. 
Files are executed consecutively from the top. 

6 When finished editing, click [OK]. 
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Appendix I Reducing the Carrier Gas Flow Rate After 
Sequential Analysis and Using the Ecology 
Mode

Reducing the carrier gas flow rate after analysis is finished is recommended to reduce carrier gas 
consumption. 

I.1 Reducing the Carrier Gas Flow Rate After 
Sequential Analysis 
For models other than QP2010 Ultra and SE, perform the following operations. 

I.1.1 Creating a Method File That Reduces the Carrier Gas Flow Rate
As an example, the following describes how to create a method file that reduces the total flow rate to 
20 mL/min. 

1 Start the [GCMS Real Time Analysis] program, then in Data Explorer, double-click the 
method file to be used for sequential analysis. 
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2 Change [Total Flow] to 20 mL/min, then name and save the method file. 

I.1.2 Creating Batch Files 

1 Click the [Batch Processing] icon on the [Real Time] assistant bar. 
The [Batch Table] window opens. 

2 In Data Explorer, double-click the batch file to be used for sequential analysis. 
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3 Right-click on the batch table and select [Table Style] on the menu that appears. 
The [Table Style] window opens. 

4 Click [Run Mode] in the [Hide Items] list, then click [Add>>] and [OK]. 
A [Run Mode] column is added to the end of the batch schedule. 
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5 Edit the batch file. 
Add a row at the end and select a method file created in "Appendix I.1.2 Creating Batch Files" P.106. 
Vial number, level number, and injection volume settings do not need to be changed from their default 
values. Enter a data file name that is not the same as any other row. 

6 Click the [Run Mode] cell for the row that specifies the method file that reduces the flow 
rate, then click the arrow button that appears. 
The [Run Mode] window opens. 

7 Configure [Run Mode] settings as shown below, then click [OK]. 

8 Name and save the batch file, then click the [Start] icon on the [Batch] assistant bar.
This results in loading the method file that reduces flow rate after the analysis for the seventh row is 
finished, which ends the sequential analysis with the carrier gas flow rate at 20 mL/min. 
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I.2 Ecology Mode (This feature applies to QP2010 Ultra 
and QP2010 SE models.) 
Using the ecology mode reduces power consumption and carrier gas consumption during standby for 
analysis. 

I.2.1 Setting the Mode Manually

1 Click the [Ecology Mode] icon in the instrument monitor. 
A message window opens. 

2 Click [Yes]. 
The [Ecology Mode] window opens and the mode switches to the ecology mode. 
After switching to the ecology mode, the column oven temperature and the total carrier gas flow rate 
decrease.

The [Ecology Mode] window is displayed when in the ecology mode. Cancel the ecology mode 
before using [GCMS Real Time Analysis] to perform operations in other windows. 

To cancel the ecology mode, click [Cancel] in the [Ecology Mode] window. 

When the ecology mode is canceled, settings before switching to the ecology mode are restored. 
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I.2.2 Setting the Mode Using Batch Processing
This allows switching the instrument to the ecology mode after the entire sequential analysis is 
finished. 

1 Click the [Batch Processing] icon on the [Real Time] assistant bar.
 The [Batch Table] window opens. 

2 Create and save a batch file. 
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I.2  Ecology Mode (This feature applies to QP2010 Ultra and QP2010 SE models.)
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3 Select [Enters Ecology Mode when ending Realtime Batch] on the [Batch] menu. 

4 Click the [Start] icon on the [Batch] assistant bar. 

5 When the ecology mode confirmation message appears, click [Yes]. 
The mode switches to the ecology mode after the sequential analysis is completely finished, including the 
batch queue.

The setting can be canceled by repeating step 3, but leave the setting as it is. 

The [Ecology Mode] window is displayed when in the ecology mode. Cancel the ecology mode 
before using [GCMS Real Time Analysis] to perform operations in other windows. 

To cancel the ecology mode, click [Cancel] in the [Ecology Mode] window. 

When the ecology mode is canceled, settings before switching to the ecology mode are restored.
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J JPrinting Reports

Reports can be output from GCMSsolution using the two methods described below.
• Image printing : The image in the displayed window is automatically converted to a report.
• Report creation : A report format is set and output manually.

J.1 Printing Images (Printing Spectra and 
Chromatograms Displayed in Windows)

1 Call up the applicable data in the [Data Analysis] window in the qualitative or 
quantitative processing modes of the [GCMS Postrun Analysis] program. 

2 Display the chromatogram and mass spectrum in the window in the way desired for the 
report.
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J.1  Printing Images (Printing Spectra and Chromatograms Displayed in Windows)
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3 Point to [Print Image] on the [File] menu and select [Edit Format].
The [Report] window opens.

4 Adjust the size as necessary. 
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5 After editing, click the [Print] icon on the [Report] assistant bar.
The report is output. 

6 After outputting the report, close the [Report] window.

J.2 Creating Reports
With report creation, reports are output after setting report formats or using previously created 
templates.
Process and save the results to be output (such as spectral information) in advance. 

1 Open the applicable data in the [GCMS Postrun Analysis] - [Data Analysis] window.
The same report is output for both the qualitative and quantitative windows.

2 Click the (Report) icon on the [Qualitative] or [Quantitative] assistant bar.
The [Data Report] window opens. 

J.2.1 Using Templates

1 Select [New Format File] on the [File] menu.
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J.2  Creating Reports
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2 Select [Use Template], select the applicable template, and click [OK].

If this selection window is not displayed, select [Option] on the [Tool] menu to display the [Setting 
Options] window and, on the [File New] tab, select [Prompt on File New] for the report format file.

J.2.2 Using Previously Created Report Files

1 In Data Explorer, double-click the report file to be used. 
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J.2.3 Manually Setting Report Content 

1 Click the buttons on the toolbar for the information to be printed or select the desired 
items on the [Item] menu. 

Icon Name Explanation
Sample information Select to print sample information.

Method Select to print methods.

Peak table Select to print the peak tables in qualitative tables.

Chromatogram Select to print the chromatograms (TIC, MIC, and MC).

Spectrum graph Select to print the mass spectra registered in spectrum processing tables.

Mass table Select to print the mass tables for the spectra registered in spectrum 
processing tables.

Quantitative graph Select to print the chromatograms and quantitative values obtained in 
quantitative results.

Quantitative table Select to print the tables obtained in quantitative results.

Calibration curve Select to print calibration curves.

Tuning Select to print the tuning results obtained when data acquisition is 
executed.

Library search Select to print the library search results obtained for the mass spectra 
registered in spectrum tables.

• Searches must be performed in the spectrum tables.
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2 Drag the mouse in the layout view to specify the print range. 
The properties window for the item being laid out opens. 

3 Set [Properties] and click [OK].

^ Reference
Refer to Help for details on property settings.

To display a properties window again, double-click on the corresponding item. 

Drag mouse diagonally 
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4 Click the [Preview] icon on the [Data Report] assistant bar and check the contents of the 
report being output. 

5 After the checking the report content, click [Print] to output the report. 

6 Select [Save Format File As] on the [File] menu to name and save the report file. 
This allows loading the report format in the future to create reports easily. 
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